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Что это такое? 
Это набор плагинов и экшенов (действий) для AdobePhotoshop, которые позволят 

вам легко удалить регулярные повторяющиеся узоры с изображений, которые не 

могут быть удобно удалены традиционными средствами. 
Пример результатов, которые могут быть легко достигнуты:
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Перечень Файлов:  

● libfftwx64_3-3.dll – FFTw Windows библиотека. Необходима к для работы плагинов. 

● Ft2DS.8bf – Windows плагин Фурье трансформации (3 канала в градациях серого). 

● Ft2DH.8bf – Windows плагин Фурье трансформации (на канал). 

● Ft3DH.8bf – Windows  плагин  Фурье трансформации (в 3 –х каналах,  цвет). 

● iFt2DS.8bf – Windows плагин обратный перерасчёт из Ft2DS. 

● iFt2DH.8bf – Windows плагин обратный перерасчёт из Ft2DH . 

● iFt3DH.8bf – Windows плагин обратный перерасчёт из Ft3DH . 

● Ft2DS.плагин – Мак плагин Фурье трансформации (3 канала в градациях серого). 

● Ft2DH.плагин – Мак плагин Фурье трансформации (за канал). 

● Ft3DH.плагин – Мак плагин Фурье трансформации (в 3 –х каналах,  цвет). 

● iFt2DS.плагин – Плагин для Mac обратный перерасчёт из Ft2DS. 

● iFt2DH.плагин – Плагин для Mac обратный перерасчёт из Ft2DH. 

● iFt3DH.плагин – Плагин для Mac обратный перерасчёт из Ft3DH. 

● Pattern Suppressor v2.7.atn - Экшены Photoshop для подавления паттернов . 

● Readme.pdf – Этот файл (Английский) 

● ReadmeRus.pdf – Этот файл. (русский)  
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Требования и совместимость 

● Требует Adobe Photoshop (64-разрядная версия) для Windows или МакОС. 

● Протестировано и подтверждено работоспособность с CS5–CC2022 на Windows10 и 

CS6–CC2018 на macOS10.13, CC2017-18 на macOS10.12 и CC2021 на macOS10.15.7 

● Скорее всего, будет работать на гораздо большем количестве версий, но мы не 

тестировали каждую комбинацию а так же не тестировались программы с Русским 

интерфейсом. 

● Требуется базовое знание того, как использовать инструмент Кисть, Cлои и панель 

Экшенов. 

 

 

Новое в v2.6, а также 2,7 

● Заменены Windows -плагины на многопоточные версии. Спасибо Франческо Пьерфедеричи  

Это дает повышение производительности (для самой трансформации, а не для остального 

действия).Сообщения об ошибках, добавленные в readme-файл 

● Номер версии и даты в Действиях были обновлены в соответствии с версией 

● плагины, чтобы избежать путаницы. 

 

Новое в v2 а также 2,5 

● Добавлены  Mac-совместимые  плагины. Спасибо  Франческо Пьерфедеричи. 

● Подавитель паттернов теперь доступен на AdobeExchange 

● Добавлены экшены/плагины для обработки цветных изображений/узоров. 

● Усовершенствован алгоритм генерации  подавляющего слоя. Он стал более точен, и теперь 

вычитает центральное “свечение”, чтобы дать гораздо лучшие результаты вблизи 

центральной звезды. 
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Установка (Windows) 
1. Скопировать файл  libfftwx64_3-3.dll в папку установки Photoshop. Обычно это: 

C:\Program Files\Adobe\Adobe Photoshop [version]\ 

При  желании вы можете скопировать его в  

C:\Windows\SysWOW64 

2.  

Копировать 8bf -файлы в папку  плагинов  Photoshop. Обычно это 

C:\Program Files\Adobe\AdobePhotoshop[version]\Plug-ins\ 

3. Перезапустите Photoshop, если он был запущен.  

4.Двойной щелчок на файле Pattern Suppressor v2.7.atn чтобы установить действия. 

(Вы также можете выбрать «Load» в меню панели  Actions…)  

Набор экшенов будет показан на панели Экшенов (можно найти в разделе Window > Actions  

(Окно >Действия). Плагины должны отображаться в списке Filter >RONC2018 

(но вы не должны запускать их вручную). 

 
Установка (Мак) 

1. Скопируйте plugin плагины - в Фотошоп, в Папку плагинов.  По умолчанию это  

/Applications/Adobe Photoshop [version]/Plug-Ins 

2. Перезапустите Photoshop,если он был запущен. 

Дважды щелкните Pattern Suppressor v2.7.atn. что бы  установить действия.  (Вы также 

можете выбрать «Load» в меню панели  Actions…)  
 

Набор экшенов будет показан на панели Экшенов (можно найти в разделе Window > Actions  

(Окно >Действия). Плагины должны отображаться под Filter >RONC2018 

(но вы не должны запускать их вручную). 

 
Как использовать 

Используйте Экшены для обработки изображений. Не запускайте фильтры вручную. 

Эти Экшены автоматически выполняют несколько дополнительных шагов обработки, чтобы 

помочь вам получить лучшие результаты (дополнение, фильтрация Найквиста и автоматическое 

подавление), а также это сэкономит вам много времени. Экшен по-прежнему допускает ручной 

ввод и настройку, если это необходимо. 

Видео руководство находится здесь: https://youtu.be/FDM4lEw65j0 
 

Если вы хотите вручную работать с преобразованиями Фурье для других целей, мы рекомендуем 

вам вместо этого пакета скачать другой пакет -github.com/rechmbrs/FtPattern . Он включает в 

себя больше плагинов, а также сценарии для помощи в обработке. 

 
 

 
 

 

https://youtu.be/FDM4lEw65j0
https://github.com/rechmbrs/FtPattern
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Краткий самоучитель 
Мы рекомендуем посмотреть видео, но вот краткая версия в письменной форме:
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Изображения в оттенках серого 
Экшен “Grayscale”  будут обрабатывать только яркость изображения. Рекомендуется для 

однотонных изображений. Если у вас есть оттенок, который вы хотите сохранить, вам придется 

создать его заново или обработать как цветное изображение. 

1. Выполните одно из первых двух действий (NORMAL - это обычно то, что вы хотите). 

Читайте сообщения после выполнения экшена. 

Полученное изображение будет выглядеть примерно так: 
 

2. Как указано в сообщении экшена, используйте инструмент «Кисть», чтобы закрасить 

черным цветом (на маске текущего слоя), чтобы раскрыть все особенности  центральной 

звезды,  а также в горизонтальные и вертикальные линии , при этом скрывая все 

остальные яркие пятна. Тогда это должно выглядеть примерно так: 
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Совет: Если вы покрасили  слишком много, нажмите X (Икс –переключатель переднего 

плана/фона выбора цвета) и закрасьте область белым, чтобы вернуть подавление. 

3. Выполните 2-й Экшен  “2 – Apply suppression”, чтобы преобразовать его обратно в обычное 

изображение. Совет: Если вы недовольны результатами, удалите или скройте слой 

“iFt”и продолжайте работать над слоем “Star suppression” до тех пор, пока не будете 

довольны (затем снова выполните 2-й экшен). 

4. Выполните 3-й экшен  “3 – Merge & trim”. Это приведет к удалению 

временного дополнения и удалению временных слоёв. 

Когда вы закончите, у вас останется два слоя: исходное изображение внизу и 

обработанное изображение сверху. 

 
Цветные  изображения 

выберите “per channel” или “3D” – они должны дать по сути идентичные результаты, но мы 

предлагаем попробовать «3D» для изображений с цветовыми узорами, если вы не уверены. 

1. Выполните одно из первых двух действий (NORMAL - это обычно то, что вы хотите). 

Читайте сообщения после выполнения экшена. 

Полученное изображение обычно будет выглядеть примерно так: 
 

2. Как указано в экшене, используйте инструмент «Кисть», чтобы закрасить черным 

цветом (на маске текущего слоя) чтобы раскрыть все особенности  центральной 

звезды,  а также горизонтальные и вертикальные линии , при этом скрывая все 

остальные яркие пятна. Тогда это должно выглядеть примерно так (красная линия 

здесь нарисована на скриншоте для наглядности: 
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Совет: Если вы покрасили  слишком много, нажмите X (Икс –переключатель переднего 

плана/фона выбора цвета) и закрасьте область белым, чтобы вернуть подавление. 

3. Выполните 2-й Экшен  “2 – Apply suppression”, чтобы преобразовать его обратно в 

обычное изображение. Совет: Если вы недовольны результатами, удалите или 

скройте слой “iFt”и продолжайте работать над слоем “Star suppression” до тех пор, 

пока не будете довольны (затем снова выполните 2-й экшен). 

4. Выполните 3-й экшен  “3 – Merge & trim”. Это приведет к удалению 

временного дополнения и удалению временных слоёв. 

Когда вы закончите, у вас останется два слоя: исходное изображение внизу и 

обработанное изображение сверху. 

 

Normal vs. Aggressive 
Для большинства изображений подходит версия “Normal”.  Агрессивная версия убьет все 

мелкие детали на изображении, но для определенных типов изображений (например, очень 

крупных полутоновых узоров, крупного полиграфического растра) Вам придётся его 

использовать. 

Единственными различиями в обработке являются настройки слоев Кривых. Поэтому, если 

вам нужно что-то промежуточное, я предлагаю вам начать с агрессивной версии, а затем 

настроить положение (вид) Кривой слоя “Strength”- ( обычно слегка обрезая блики). 
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Вот сравнение настроек по умолчанию: 

 

 

Сообщения об ошибках 

 
То объект "слой «ХХХ»» в данный момент недоступен: 

 

 

При запуске действий появится это сообщение об ошибке, если действие не сможет найти слой 

,необходимый для работы (имя “Preview”  на скриншоте выше будет заменено на любой из 

имени девяти слоёв, который он не может найти).Обычно это происходит, если вы случайно 

удалили/переименовали один или несколько жизненно важных слоев во время обработки или 

выполняете действия в неправильном порядке. 
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Пожалуйста, прочитайте ещё раз этот самоучитель для получения дополнительной 

информации о том, как правильно использовать наши экшены. 

 
Команда “Фильтр”в данный момент недоступна 

 

 
При выполнении любого из действий это сообщение об ошибке появится, если не удастся найти один или 

несколько фильтров (плагинов). Это,  как правило означает что вы не скопировали фильтры в правильную  

папку или забыли перезапустить Photoshop после этого. Пожалуйста, убедитесь, что плагины 

(фильтры)находятся в правильной папке для вашей версии Photoshop (и что вы используете 64-

разрядную версию Photoshop, которая поддерживает фильтры). 

Если фильтры установлены правильно, они должны отображаться под 

Filter >RONC2018 

 

Не удалось завершить ХХХ.команда из-за ошибки диска 
 

 

Это  вводящее  в  заблуждение  сообщение  об  ошибке  появится  в  Windows, если 

libfftwx64_3-3.dll пропал без вести. Обычно это означает, что вы не скопировали файл в нужную 

папку или забыли перезапустить Photoshop после этого. Обратите внимание, что “Ft2DS”на 

приведенном выше скриншоте - это имя фильтра, который он пытался запустить это время, и 

будет отличаться в зависимости от того, какое действие/фильтр вы запускали. Пожалуйста, 

убедитесь, что libfftwx64_3-3.dll находится  в  правильной  папке  для  правильной  версии  

Photoshop. 

 

Как работает магия Фурье 
Этот раздел не является обязательным чтением для использования действий. Это для тех, у кого 

есть дополнительный интерес, кто хочет узнать больше. Это также важная информация, если вы 

хотите понять и изменить Экшены. 
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Ft plug-ins 

Плагины (фильтры) используют преобразование Фурье для преобразования текущего слоя в 

частотную область. Обратные версии преобразуются обратно. Плагины работают на 8, 16 и 32-

битных изображениях, но использовать 8-битные не рекомендуется, так как он не имеет 

требуемой точности – вы получаете шум, генерируемый ошибками усечения (вы заметите это в 

основном как нежелательные сдвиги яркости/контрастности после преобразования его обратно). 

См. github.com/rechmbrs/FtPattern  для дополнительных плагинов преобразования Фурье и скрипта 

для работы с ними. 

 

Фильтр Ft2DS (преобразование Фурье, 2D, одноканальный) усредняет каналы перед преобразованием. 

Амплитуды частоты сохраняются в красном канале, фаза в зеленом канале, а синий канал используется 

для хранения копии входного сигнала (но на самом деле он ни для чего не 

используется).Обратите внимание, что действия, использующие этот фильтр, будут использовать 

его для яркости изображения. 

 

Фильтр  Ft2DH -(преобразование Фурье,2D, половинная ширина) выполняет преобразование по 

цветному каналу. Амплитуды частоты хранятся на левой половине, фазы - на правой. Это 

сделано, потому что недостающая половина на самом деле является просто дубликатом, 

повернутым на 180градусов (как вы можете видеть при запуске Ft2DS).Самые правые 2столбца 

пикселей из входных данных будут проигнорированы, поэтому вы должны заполнить 

изображение перед обработкой (ему нужны 2-а дополнительных столбца для хранения всех 

частот).Эта панель с 2-мя столбцами выполняется автоматически в экшене подавления паттерна. 

 

Фильтр Ft3DH (преобразование Фурье, 3D, половинная ширина) выполняет преобразование в 

3D-пространстве. ( три канала обрабатываются подобно X, Y, а также Z-координаты). Частота 

амплитуды хранится на левой половине, фаза на правой . Самые правые 2 столбца пикселей  из 

входных данных будут проигнорированы, поэтому перед обработкой  вам следует дополнить 

изображение (для хранения всех частот ему нужны  2 дополнительных столбца). 

Когда  изображение находится в в частотной области  вы должны увидеть несколько ярких 

звезд/пятен на левой стороне  (или  в красном канале для Ft2DS), если ваше изображение 

содержит периодически повторяющиеся узоры. Подавление этих частот путем затемнения 

этих ярких пятен приведет к подавлению повторяющихся узоров на изображении. 

Обратите внимание, что большую звезду в центре и две линии, которые обычно проходят через 

нее, не следует подавлять (иначе ваше изображение будет практически уничтожено). 

iFt-плагины преобразуют данные обратно из частотной области в обычное изображение. 

 

 

 

 

https://github.com/rechmbrs/FtPattern
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Набор Экшенов (Действий) 

Набор действий направлен на радикальное ускорение и упрощение процесса подавления 

периодических узоров на изображении, а также на выполнение дополнительной обработки, 

которая обычно упускается пользователями, но которая улучшает качество Результата  (старые 

учебные пособия просто скажут вам закрасить шипы черной или серой кистью, но это 

даст худшие результаты). 

Первый Экшен начинается с дополнения изображения перед выполнением 

преобразования Фурье. Это предотвратит появление большого количества нежелательных 

узоров на краях изображения после выполнения подавления узоров, а также заполнение двух 

крайних правых столбцов изображения. Дополнительные 

пиксели при выполнении цветовых преобразований необходимы для обработки (и не должны 

содержать полезных данных изображения). Затем он дублирует слой изображения (так что у 

вас есть резервная копия оригинала) и выполняет преобразование Фурье (используя 

выбранный плагин Ft). 

Чтобы автоматически скрыть яркие пятна в данных амплитуды (источник повторяющихся шаблонов 

на изображении), действие создаст дубликат информации об амплитуде и использует радиальное 

размытие (масштабирование + вращение) для создания изображения, состоящего только из 

радиальных свечения (“glow”).  Затем это вычитается из ещё одной копии и  возводится в квадрат, 

оставляя изолированные темные звезды на белом фоне. Он устанавливается  режим Multiply ( 

Умножение) к слою с исходной амплитудой, чтобы убрать яркие пятна. Короче говоря, он создает 

темные пятна поверх ярких пятен, чтобы подавить их. Слой кривых используется для настройки 

подавления, чтобы либо избежать слишком сильного подавления путем обрезания светлых участков 

(«НОРМАЛЬНОЕ подавление»), либо усилить подавление, затемнив его и ничего не отсекая 

(«АГРЕССИВНОЕ подавление»). Вы можете настроить слой кривые, чтобы, например, получить что-

то промежуточное. Это также слой для «Предварительного просмотра» который при 

НОРМАЛЬНОМ режиме делает подавление более 

заметным во время маскировки (но игнорируется при обработке). 

Центральная звезда и две линии, которые обычно проходят через середину, также скрываются 

автоматическим подавлением, поэтому добавляется маска слоя, и пользователю предлагается 

вернуть их, нарисовав на маске (окраска черным скрывает части слоя подавления). 

Сверху генерируется слой с фильтром Найквиста (Nyquist filter). Это сглаживающий фильтр, 

который предотвращает нежелательные артефакты от в самой высокой частоты в результате 

трансформации  (почти подобно муар). Это будет иметь наибольшее влияние на изображения с 

чрезвычайно мелкими (на пиксель) деталями/узорами. Внешние края данных амплитуды 

представляют самые высокие частоты на изображении, многие из них находятся за пределами 

частоты Найквиста, а этот слой просто подавляет их на 50 % — с постепенным переходом. 

Окончательное изображение будет немного мягче с этой фильтрацией, но это происходит  в 

первую очередь из-за меньшего количества высокочастотного шума и артефактов размером с 

пиксель (и, надеюсь, не из-за отсутствия действительно полезных деталей изображения). Вы 

можете установить непрозрачность на 0% или заполнить белым цветом, чтобы отключить его. 

https://en.wikipedia.org/wiki/Nyquist_frequency
https://en.wikipedia.org/wiki/Nyquist_frequency
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2-й экшен  (“2 – Apply suppression”) объединит копии соответствующих слоев и запустит обратное 

преобразование Фурье. Он сохраняет все в слои нетронутыми, поэтому, если вы недовольны 

результатами, вы можете просто удалить слой “iFt”и продолжить работу над слоем подавления 

паттернов. 

Совет:Вместо того чтобы удалять слой, вы можете выключить его отображение (и я предлагаю 

переименовать его). Это позволяет быстро сделать несколько попыток подавления и сравнить их.  

3-й и последний экшен просто обрезает отступ, созданный на первом шаге, и удаляет 

все лишние слои, используемые в процессе. Сверху останется ваш iFT-слой (и любые 

дополнительные версии, которые вы сделали),а внизу - исходное неизмененное 

изображение. 

Source code 

Source code, plugins for additional types of transformations, and a script for working with them, can be 

found at github.com/rechmbrs/FtPattern 

 

Copyright 

In short, these tools are free for personal and commercial use. Here are the details: 
Fourier Transformation plugins 

The copyright for the Ft2DS, Ft2DH, Ft3DH, iFt2DS, iFt2DH and iFt3DH plugins is an extension of the 

FFTw copyright and the assumed copyright for FFT_RGB routines from Alex Chirikov original source 

code while at Drexel University. 

Modifications to FFT_RGB have been made by: 

● Alex Chirokov 

Drexel University, 2005 

● Phil Thornton, www.mdr.co.nz 

April 2010 

● Ron Chambers, rechmbrs@gmail.com 

February 2018 

● Francesco Pierfederici, fpierfed@megabeets.com 

August 2018 

Release of the plugin-files as continuation of FFT_RGB routines FFT.8bf 

and IFFT.8bf. The 8bf routines are plugins for Adobe Photoshop and have used the Adobe 

Photoshop SDK routines**. Compilation and rules for coding were set by Microsoft 

https://github.com/rechmbrs/FtPattern
http://www.mdr.co.nz/
mailto:rechmbrs@gmail.com
mailto:fpierfed@megabeets.com
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Visual Studio 2017 Community. 

The original Chirokov code was available in the public domain with no specific 

license attached. However, it makes use of the fftw library, which is published under the GNU license, 

which inter alia provides that any software using it must also be published under the GNU. This means 

you must publish the source, and it must be free. 

This program is free software; you can redistribute it and/or modify it under the terms of the GNU 

General Public License as published by the Free Software Foundation; either version 2 of the License, 

or (at your option) any later version. 

Эта программа распространяется в надежде, что она будет полезна, но БЕЗ КАКИХ-ЛИБО 

ГАРАНТИЙ; даже без подразумеваемой гарантии ТОВАРНОЙ ПРИГОДНОСТИ или 

ПРИГОДНОСТИ ДЛЯ ОПРЕДЕЛЕННОЙ ЦЕЛИ. Более подробную информацию смотрите в 

разделе GNUGeneralPublic License 

** ADOBE SOFTWARE DEVELOPMENT KIT LICENSE FOR ADOBE TECHNOLOGY NAMED ADOBE® PHOTOSHOP® SDK 

Pattern Suppressor actions 

The actions were created by Jonas Madsen Rogne (jonas@rognemedia.no) aka Chain, with technical 

advice from Ronald Chambers (rechmbrs@gmail.com). You are free to modify and redistribute the 

actions. But you may not sell them or claim ownership. 

Libfftwx64_3-3.dll 

FFTw is Copyright © 2003, 2007-11 Matteo Frigo, Copyright © 2003, 2007-11 Massachusetts Institute 

of Technology. 

FFTw is free software; you can redistribute it and/or modify it under the terms of the GNU General 

Public License as published by the Free Software Foundation; either version 2 of the License, or (at your 

option) any later version. 

This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; 

without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR 

PURPOSE. See the GNU General Public License for more details. 

You should have received a copy of the GNU General Public License along with this program; if not, 

write to the Free Software Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 

USA You can also find the GPL on the GNU web site. 

In addition, we kindly ask you to acknowledge FFTw and its authors in any program or publication in 

which you use FFTw . (You are not required to do so; it is up to your common sense to decide whether 

you want to comply with this request or not.) For general publications, we suggest referencing: Matteo 

Frigo and Steven G. Johnson, “The design and implementation of FFTW3,” Proc. IEEE 93 (2), 216–231 

(2005).Non-free versions of FFTw are available under terms different from those of the General Public 

License. (e.g. they do not require you to accompany any object code using FFTw with the corresponding 

source code.) For these alternative terms you must purchase a license from MIT’s Technology Licensing 

Office. Users interested in such a license should contact us (fftw@fftw.org) for more information. 

Перевод Igor Bon 

mailto:jonas@rognemedia.no
mailto:rechmbrs@gmail.com
http://www.fftw.org/
http://www.gnu.org/licenses/gpl-2.0.html
http://www.gnu.org/licenses/gpl-2.0.html
http://www.gnu.org/licenses/gpl-2.0.html
mailto:fftw@fftw.org

